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ВВЕДЕНИЕ 

 Для выполнения представленных в настоящем методическом ру-
ководстве лабораторных работ предлагается использовать систему 
автоматизированного проектирования Advanced Design System, кото-
рая предназначена для моделирования аналоговых и цифровых радио-
электронных устройств и систем широкого класса. Ниже приводится 
последовательность основных команд, ориентированных на сеанс 
работы с программным обеспечением данной САПР. 

1.  Запустить программу Advanced Design System. Сгенерируется 
окно главного меню. 

2.  Установить режим работы системы – аналоговый, если это необ-
ходимо, выполнив команду Optiotis> Advanced Design System 
Setup>Analog RF Only. Выйти из программы и снова ее запустить. 

3. Создать новый проект – команда File>New Project. 
4.  Присвоить имя новому проекту и открыть его. К имени автома-

тически присоединяются символы _prj. 
5. Открыть окно схемного редактора командой File>New Schematic. 
6. Сформировать схемный проект. 
7.  Сохранить содержимое окна схемного редактора. Файл получает 

расширение *.dsn и размещается в подкаталоге network. 
8. Результаты моделирования (графики, таблицы и т.п.) сохранить 

в файле с расширением *.dds. 
Далее приводится описание лабораторных работ, ориентированных 

на изучение спектральных характеристик типовых радиосигналов и 
способов их оценки, изучение принципов работы простейших детек-
торов модулированных сигналов для различных видов модуляции, 
исследование характеристик амплитудных и частотных детекторов 
при вариации параметров сигналов и элементов схемы. 
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Лабораторная работа № 1 

ИССЛЕДОВАНИЕ СПЕКТРАЛЬНЫХ ХАРАКТЕРИСТИК 
ПЕРИОДИЧЕСКИХ И НЕПЕРИОДИЧЕСКИХ СИГНАЛОВ  

1. Цель работы 

Формирование моделей периодических и непериодических сигна-
лов, исследование амплитудного и фазового спектров сигналов  с 
использованием методов решения системы дифференциальных урав-
нений, описывающих поведение схемы во временной области, и 
прямого преобразования Фурье. 

2. Теоретическая часть 

Под сигналом S(t) будем понимать изменение во времени одного 
из параметров физического процесса. Классификация сигналов по 
ряду признаков отражена на рис. 1. 

 
 
 
 
  

 
 
 

Случайные 

Сигналы 

Детерминированные 

Полезный 
сигнал 

Случайная 
помеха (шум) 

Перио- 
дические 

Неперио- 
дические 

Рис.1. Классификация сигналов 
Детерминированным называется сигнал, который точно опреде-

лен в любой момент времени (например задан в аналитическом виде). 
Детерминированные сигналы могут быть периодическими и неперио-
дическими. 

Периодическим называется сигнал, для которого выполняется условие 

S(t) = S(t + кT), 

где к – любое целое число, Т – период, являющийся конечным отрез-
ком времени.  

Пример периодического сигнала – гармоническое колебание 
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Любой сложный периодический сигнал может быть представлен в 
виде суммы гармонических колебаний с частотами, кратными основ-
ной частоте ω= 2π /T. 

Непериодический сигнал, как правило, ограничен во времени. 
Случайным сигналом называют функцию времени, значения ко-

торой заранее неизвестны и могут быть предсказаны лишь с некото-
рой вероятностью. В качестве основных характеристик случайных 
сигналов принимают: 
     а) закон распределения вероятности (относительное время пребы-
вания величины сигнала в определенном интервале); 
     б) спектральное распределение мощности сигнала. 

 
Спектральный анализ периодических сигналов 

Известно, что любую функцию S(t), кусочно-непрерывную на ин-
тервале а < t < b и ограниченную по норме 

2

( )
b

a

S t dt < ∞∫ , 

можно разложить в ряд, называемый обобщенным рядом Фурье, по 
полному набору (базису) ортогональных функций Ψn(t):  

)()()()( 1100 tCtCtCtS nnΨ+Ψ+Ψ= … . 
Функции Ψk(t) называются ортогональными, если выполняются 

соотношения 

∫ =ΨΨ ∗
b

a
km dttt 0)()(  при m  к;    ≠ ∫ Ψ=ΨΨ ∗

b

a
kkk dttt 2)()( – норма при m = k. 

Для комплексных функций Ψk(t), Ψk
*(t) есть комплекснo-

сопряженная ей функция. Коэффициенты ряда определяются сле-
дующим выражением: 

2

)()(

k

b

a
k

k

dtttS
C

Ψ

Ψ
=
∫ ∗

. 
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В радиотехнике в качестве базисных функций разложения Фурье 
используют преимущественно тригонометрические функции. Это объ-
ясняется следующими причинами: 

 
 



     а) функции cosωt, sinωt являются простыми, определены при всех 
значениях t, являются ортогональными и составляют полный набор 
при кратном уменьшении периода; 
     б) гармоническое колебание является единственной функцией 
времени, сохраняющей свою форму при прохождении колебания 
через линейную систему с постоянными параметрами, могут изме-
няться лишь амплитуда и фаза; 
     в) для гармонических функций и их комплексного анализа имеет-
ся мощный математический аппарат, найдены спектры множества 
форм сигналов; 
     г) гармоническое колебание легко осуществить на практике. 

Спектр периодического сигнала является дискретным и пред-
ставляет набор гармонических колебаний, в сумме составляющих 
исходный сигнал. Одним из преимуществ разложения сигнала в 
спектр является следующее. Токи и напряжения в цепи под действи-
ем сигнала описываются дифференциальными уравнениями, соот-
ветствующими элементам цепи и способу их соединения. Линейные 
цепи описываются линейными дифференциальными уравнениями, 
причем для линейных цепей верен принцип суперпозиции, согласно 
которому действие на систему сложного сигнала, состоящего из 
суммы простых сигналов, равно сумме действий от каждого состав-
ляющего сигнала в отдельности. Это позволяет при известной реак-
ции системы на какой-либо простой сигнал, например, на синусои-
дальное колебание с определенной частотой, определить реакцию 
системы на любой сложный сигнал, разложив его в ряд по синусои-
дальным колебаниям. 

Спектральный анализ непериодических сигналов 

Пусть задан сигнал в виде ограниченной во времени функции S(t), 
отличной от нуля в промежутке t1t2, как показано на рис. 2.  

Выделим произвольный отрезок времени T, включающий промежу-
ток t1t2, далее продолжим аналитически S(t) на всю бесконечную ось с 
периодом T. Тогда мы сможем разложить такую периодическую функ-
цию S(t) в гармонический ряд Фурье. В комплексной форме будем иметь 
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Полученный ряд на участке [t1, t2] будет точно соответствовать 

нашей функции S(t). Однако, если нас интересуют моменты вре-
мени за участком [t1, t2], то необходимо увеличить период Т, т. е. 
отодвинуть повторные значения функции S(t). Производя замену 
переменных и переходя от суммирования к интегрированию, 
получим 

1
2 d
T
π

ω = → ω , 1nω →ω ; 
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i t i ts t e s t e dt
∞ ∞

ω − ω
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где  – спектральная плотность сигнала S(t). ( )S ω�

Рис.2. Пример непериодического сигнала 
t 

t t2t1

 
Спектр непериодического сигнала сплошной (непрерывный) и рас-

пространяется на отрицательные частоты. 
Если S(ω) = A(ω) + iB(ω), то 2( ) ( )S S Aω ≡ ω = +� 2B  – модуль 

спектральной плотности  или амплитудно-частотная характеристика 

 
 



arctg B( )( )
A( )

ω
ϕ ω =

ω
 – фазово-частотная характеристика. 

Необходимое условие существования спектральной плотно-

сти ∞<∫
∞

∞−

dtts 2)( . 

3. Задание 

3.1. Создать рабочий проект в среде САПР ADS или открыть 
имеющийся. 

3.2. Сформировать схемный проект, включающий последователь-
ное соединение  источника напряжения периодической последова-
тельности импульсов во временной области (компонента V_Pulse из 
группы Sources Time Domain) и 50-омного резистора. 

3.3. Установить имя выходного напряжения на узел соединения 
резистора и источника напряжения. 

3.4. Определить параметры источника напряжения V_Pulse (рис. 3, 4) со-
гласно заданному варианту последовательности прямоугольных импульсов: 

VtPulse
SRC1

Period=10 nsec
Width=3 nsec
Fall=1 nsec
Rise=1 nsec
Edge=linear
Delay=0 nsec
Vhigh=1 V
Vlow=0 V

t

Рис. 3. Задание параметров им-
пульсного источника напряжения 

 
Vlow – нижний уровень импульсов; 
Vhigh – верхний уровень импульсов; 
Delay – время задержки; 
Edge – закон изменения переднего и заднего фронтов импульсов 

(linear – линейный); 
Rise – время нарастания переднего фронта импульсов; 
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Fall – время спада заднего фронта импульсов; 
Width – ширина вершины импульсов. 

                   Vhigh       
 
 
 
 
 

                          Vlow     
     
                 
 
                                    Delay     Rise     Width      Fall                       Period                                                                                   

Рис. 4. Определение параметров импульсного источника 
В данном случае время задержки, нарастания и спада принять равным мини-

мальному значению шага временного анализа, деленному на 10 – 100 (см. ниже). 
3.5. Выбрать и разместить на схеме контроллер проведения анализа во 

временной области (компонента TRAN из группы Simulation Transient). 
Определить временные параметры анализа в диалоговом окне Time Setup 
размещенного контроллера: начальное время анализа Start time = 0, конеч-
ное время анализа Stop Time, которое должно быть быть установлено 
равным 100 периодам входного сигнала; минимальное значение шага 
анализа (min time step) может быть выбрано равным 1/10 ширины самого 
узкого участка периода входного сигнала (уменьшение этого параметра 
увеличивает точность анализа и его время). Минимальное значение шага 
анализа будет определять максимальную частоту рассчитываемого спектра. 

3.6. Запустить проект на анализ командой Simulation>Simulate. 
3.7. Вывести в окне просмотра выходных результатов временную раз-

вертку выходного напряжения и, при необходимости, локализовать ее в 
области наблюдаемых  процессов для более удобного наблюдения.  

9

своив его какому-либо идентификатору, например SPECTR1, (рис. 5). 

Вывести в окне просмотра выходных результатов компоненту Eqn 
и сформировать уравнение, реализующее функцию прямого преобра-
зования Фурье fs(vout), где vout – имя выходного напряжения, при-

Рис. 5. Определение уравнения для выполнения 

Eqn SPECTR1=fs(out)

Фурье-анализа..... 

 
 



Открыть окно построени ямоугольной системе ко-
орд

Рис

Выполнить оценку амплитуд произвольных двух гармоник 
спе

риод следования импульсов в два раза, 
получить временные развертки и амплитудные спектры. Наблюдать 
изменения спектра. 

я графика в пр
инат (Rectangle). В окне Datasets and Equations  выбрать группу 

Equations, а в ней – имя сформированного уравнения (SPECTR1) и 
добавить его на график (Add), предварительно выбрав форму вывода 
амплитудного спектра – Magnitude. Разместить маркеры в оцени-
ваемых частотных точках спектра. В результате сформируется изо-
бражение, приведенное на рис. 6. 

. 6. Спектр периодической последователь-
ности импульсов и временное изображение 

сигнала 

ы для 
ктра с помощью маркеров. 
Увеличивая и уменьшая пе
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11

ти фронта нарастания и длительности вершины 
имп

 контроллере 
TR

4.2. Теоретическая часть, включающая последовательность опре-
деления амплитудного с ала в общем виде с 
кол анных двух гармоник для сравнения с 
рез

ания и рассчитанные графиче-
ски

ние в ряд 
Фурье.  

2. Применение фор реобразования Фу-
рье

чет свойства четности и нечетности сигналов при спектраль-
ном

рье (сдвиг во времени сигнала, 
сжа

3.8. Преобразовать источник прямоугольных импульсов в источ-
ник пилообразного сигнала. Для этого достаточно поменять местами 
значения длительнос

ульса в источнике сигнала. Провести спектральный анализ при 
различных значениях периода. Наблюдать изменения спектра. Срав-
нить спектры прямоугольных и пилообразных сигналов. 

3.9. Восстановить параметры исходного источника прямоугольных 
импульсов. Установить значение периода последовательности далеко за 
пределами времени проведения анализа, определенного  в

AN, моделируя тем самым эффект одиночного импульса. 
3.10. Выполнить спектральный анализ для двух различных значе-

ний длительности импульса. Вывести амплитудные спектры и вре-
менные развертки сигнала. Наблюдать изменения спектра. 

4. Содержание отчета 

4.1. Цель работы, задание. 

пектра исходного сигн
ичественной оценкой выбр
ультатами, полученными в п. 3.10. 
4.3. Схемные проекты для проведения исследований с синусои-

дальным и импульсным источниками и результаты моделирования. 
4.4. Полученные в ходе моделиров
е зависимости. 
4.5. Выводы по результатам проведенных исследований. 

5. Контрольные вопросы 

1. Спектральный анализ периодических сигналов. Разложе

мул прямого и обратного п
 для непериодических сигналов. 
3. У
 анализе. 
4. Свойства преобразования Фу
тие и расширение сигнала). 

 
 



5. Свойства преобразования Фурье (дифференцирование и ин-
тег

Фурье (произведение колебаний). 

ункции. 
иза  

пре
 

Таблица 1 

Вариант 
В
уровень 
сигнала, В 

уровень 
сигнала, В 

 
вершины 

импульса, нс 

Период 
следования 
имп

рирование колебаний). 
6. Свойства преобразования 
7. Свойства спектра последовательности прямоугольных импульсов. 
8. Свойства дельта-ф
9. Формирование проекта для проведения спектрального анал
дложенной схемы в среде САПР ADS. 

6. Варианты параметров сигналов 

ерхний Нижний Длительность

ульсов, 
нс 

1 1 0 200 800 
2 2 -2 100 800 
3 1 -2 500 1500 
4 4 2 100 400 
5 1 -4 400 1200 
6 2 1 200 1000 
7 0 -2 100 1  000
8 2 -4 200 1200 

 
 
 

Лабораторн  № 2

ИССЛЕДОВАНИЕ СИГНАЛОВ С АМПЛИТУДНОЙ 

Изучение и исследование временных и спектральных характери-
стик сигналов с амплитудно М); изучение принципов 
детектирования сигналов с АМ-модуляцией. 

    
 

ая работа   
 

МОДУЛЯЦИЕЙ 
 

1. Цель работы 
 

й модуляцией (А
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2. Теоретическая часть 

Описание сигналов с амплитудной модуляцией 

13

В щем виде сигнал с амплитудной модуляцией (рис. 7) может 
быть писан следующим образом: 

 об
о

0 0( ) ( )cos( )a t A t t= ω + θ , 

где A(t) – мод
cos(ω0t + θ0) – 
ω0 –

ания. 
 

ьное относительное 

улирующий (управляющий) сигнал, 
несущий сигнал(колебание), 

 частота несущего колебания, 
θ0 – начальная фаза несущего колеб

Глубина амплитудной модуляции – максимал
отклонение амплитуды от среднего  

minmax 22 AA +
max2AM min2A−

= ,  

де   г max min,A A – соответственно максимальное и минимальное значе-
ния модулированного сигнала (рис. 7). 

 
Рис.7. АМ-сигнал и оценка глубины модуляции 

 
Определение спектра амплитудно-модулированного сигнала 

 
Спектральную плотность АМ-сигнала, представляющего собой 

произведение жно опреде-
лить на основании интеграла свертки  

модулирующего и несущего сигналов, мо

1( ) ( ) ( )
2a AS S d

∞
′ ′� � �

−∞

ω = ω Φ ω− ω ω
π ∫ , 

где  ( )AS ω  – спектральная плотность функции А(t); 

 
 



0( ) ( )ie eθ −
0 )iθ (⎡ ⎤′δ ω+ω −ω⎣ ⎦  - спектральная 

плотность несущего сигнала. Тогда 

′ ′Φ ω−ω = π δ ω−ω −ω +

0
0) ( ) ( )

2
i

Ae S dθ

−∞

′ ′ ′= ω δ ω − ω − ω ω +∫ �

0

1(

1 ( ) ( ) ,

a

i

S

e S d

∞

∞
− θ

ω

′ ′+ ω δ ω + ω − ω ω∫

�

�
 

02 A
−∞

0 0
1 1( ) ( ) ( )
2 2

i i
a A AS e S e Sθ − θω = ω−ω + ω+ω� � � . 

Таким образом, спектральная плотность модулированного сигнала 
представляет собой два спектра модулирующей функции, построен-
ных относительно частот ω  =  ω0 и ω  =  -ω0 (сдвинутых на частоты 
несущей), как показано на рис. 8. 

 
Рис. 8. Спектр информационного и АМ-сигналов в 

общем виде 
 

Пример определения спектра АМ-сигнала при гармоническом 
модулирующем сигнале 

В случае гармонического  АМ-сигнал 
может быть описан с помощью следующего выражения: 

где Ω – частота модули
φ – начальная фаза я. 

 модулирующего воздействия

0 0 0 0 0 0( ) cos( ) cos( )cos( ),a t A t A M t t= ω + θ + Ω + ϕ ω + θ  

рующего колебания, 
 модулирующего колебани

Используя тригонометрические преобразования, второе слагаемое 
может быть сведено к виду 

[ ] [0 0
0 0 0cos ( ) cos ( )

2 2
t tω +Ω +ϕ+θ +ϕ + ω −Ω + ]0 .A M A M

ϕ+θ −ϕ     

еским колебаниям 
с ч

Это выражение соответствует новым гармонич
астотами ω0 + Ω и ω0 - Ω, соответствующими верхней и нижней 
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боковым частотам модуляции. Зависимость модуля спектральной 
плотности от частоты приведена на рис. 9. 
 

 
Рис. 9. Спектральная отность АМ-сигнала 

при однотонал  
  

Амплитудное детектирование 

Амплитудный элемента и низ-
кочастотного фильтра вход детектора пода-
ется дулирован

 
 
 
 
 

   
   

пл
ьной модуляции

 детектор состоит из нелинейного 
 в качестве нагрузки. На 

мо ный сигнал 0( ) ( )cose t E t t= ω . На выходе
ал E(t). Различают два способа

 детектора 
генерируется сигн  детектирования 
АМ

ывающегося на

. 

 
                     

Рис.10. Пример схемы детектора АМ-сигналов  
элемента при квадратичном 

В этом случае выходной ток нелинейного элемента можно запи-
сать следующи

-сигнала – квадратичный и линейный. 
Квадратичное детектирование осуществляется при малой ампли-

туде сигнала, полностью уклад  нижнем квадратичном 
участке вольт-амперной характеристики нелинейного элемента, на-
пример полупроводникового диода (рис. 10)

а)                                         б) 
на диоде а) и отклик нелинейного

детектировании б) 

м образом: 
)()()()( 2

210 teateaUItI ++= . 
2 2

0 1 0 2 0( ) ( ) ( )cos ( )cosI t I U a E t t a E t t= + ω + ω =  

2 22 2
0 1 ( )c a a

0 0os ( )cos2
2 2

I a E t= + t E t t Eω + ω + . 

ωω0-Ω ω0 ω0+Ω 

Sa(ω)

 
 



Высокочастотные составляющие ω0 и 2ω0 отфильтровываются. 
Информация содержится в последнем низкочастотном слагаемом. 

)(
2 2 tEaI  
1 2= , при условии 2 2RCπ

0

π
>> >>

Ω ω
.  

Следует заметить, что если вывести напряжение смещения U0 на 
линейный участок  характеристики, то детектирова-
ния вообще не буд  случай тональной модуляции, когда 
АМ

 вольт-амперной
ет. Рассмотрим

-сигнал представляется в виде 
)cos1()( 0 tMEtE Ω+= . 

В этом случае 
22

0 (1 2 cosaI E M 2 2

2 2
22

0

cos )
2

(1 2 cos cos2 ).
2 2 2

t M t

M Ma E M t t

+ Ω =

+ + Ω + Ω
 

Как видно, при квадратичном детектировании появляется пара-
зитная двойная частота. При модуляции несколькими частотами 
возникают еще комбинированные частоты с амплитудами, пропор-
цио

Рис

 

= + Ω

=

нальными произведению индексов модуляции (М1М2). Для 
уменьшения амплитуд высших комбинационных гармоник нужно 
уменьшать глубину модуляции М. Если требуется неискаженное 
воспроизведение сигналов (музыка), то квадратичное детектирование 
применять нецелесообразно. 

.11. Отклик нелинейного элемента на АМ-сигнал при линей-
ном детектировании 
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Линей уде 
сигнала при кусочно-линей и детектора (рис. 11). 

ное детектирование осуществляется при большой амплит
ной аппроксимаци

Когда речь идет о линейном детектировании, не следует, конечно, 
упускать из виду то, что детектор, работающий с отсечкой тока, являет-
ся сугубо нелинейным устройством. Эта нелинейность обусловлена 
формой характеристики не только в области u > 0 (где характеристика 
может быть близка к линейной), а на протяжении всей области дейст-
вующих на диоде напряжений. При работе с отсечкой характеристика 
диода представляет собой ломаную линию, состоящую из участка оси 
абсцисс (при u < 0) и наклонной линии (при u > 0), с изломом вблизи 
точки и = 0.Режим модуляции накладывает на выбор элементов нагруз-
ки детектора дополнительные ограничения. Необходимо, чтобы посто-
янная времени цепи нагрузки была мала по сравнению с периодом 
модуляции. В противном случае изменение выпрямленного напряжения 
на нагрузке может отставать от изменения огибающей входной ЭДС. 
Подобный режим представлен на рис. 12. На участке а – б из-за чрез-
мерно большой инерционности RC-цепи напряжение uвых отстает в 
своем росте от огибающей ЭДС. В точке б, где uвых и амплитуда моду-
лированной ЭДС уравниваются, ток через диод и рост uвых прекращают-
ся. На участке б – в источник ЭДС и диод не оказывают никакого влия-
ния на нагрузочную цепь и в последней происходит разряд конденсато-
ра С через резистор R. Таким образом, на участке б – в напряжение 
является экспонентой. Получается нелинейное искажение сигнала. Так 
как эти искажения обусловлены тесным взаимодействием нелинейного 
элемента (диод, транзистор) с линейной цепью (RC), степень нелиней-
ных искажений зависит не только от параметров цепи и глубины моду-
ляции, но также и от частоты модуляции. Эти искажения возрастают с 
повышением частоты, а также глубины модуляции входной ЭДС. Для 
устранения рассматриваемых искажений необходимо, чтобы выполня-
лось неравенство RC << 2π/Ω. Однако для сглаживания высокочастотных 
пульсаций требуется выполнение неравенства RC >> 2π/ω0. Совмещая 
эти два условия, получаем неравенство, определяющее условие неиска-
женной передачи информационного сигнала 

2π/ω0 << RC << 2π/Ω. 

 
 



Обычно частóты ω0 и Ω сильно различаются (Ω << ω0) и выполне-
ние условия не встречает затруднений. 
 

 

Рис. 12. Случай правильного (а) и неправильного (б) выбора параметров RC-
нагрузки АМ-детектора 

 
При импульсной модуляции огибающей в правой части неравен-

ства вм -
тельность импульса. При этом , что интервалы меж-
ду 

 ADS в рабочем каталоге. Установить 
аналоговый режим работы системы (команда главного меню 
Tools>ADS Setup>Analog RF

о  
декс модуляции m = 0,5. Выпол-

нит

есто периода модуляции 2π/Ω следует подставлять дли
 предполагается

импульсами велики по сравнению с длительностью импульса. 
При очень коротких импульсах, длительность которых всего лишь в 
несколько раз превышает период Т0 = 2π/ω0 («высокочастотный 
голод»), возникают трудности с разделением огибающей и высоко-
частотного заполнения. 

 
3. Задание 

3.1. Создать проект САПР

 only).  
3.2. Подготовить схемный проект для проведения анализа источ-

ника АМ-сигнала во временной области при синус идальном моду-
лирующем сигнале. Установить ин

ь анализ на интервале 5 – 10 периодов модулирующего сигнала.  
3.3. Вывести временную развертку АМ-сигнала на выходе моду-

лятора и с помощью маркеров и уравнения определить эксперимен-
тально значение глубины модуляции. 
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 маркеров определить амплиту-
ды 

ник импульсного сигна-
ла т

 0,5. Частота следования прямоугольных импульсов должна 
соо

 с ф

-сигналов, 
вкл

-фильтра. Выполнить анализ. 

ормуле 

3.4. Выполнить спектральный анализ выходного сигнала. Вывести 
амплитудный и фазовый спектр АМ-сигнала, локализованный в окре-
стности несущей частоты. С помощью

и фазы всех спектральных составляющих. 
3.5. Повторить анализ п. 3.3 для значений индекса модуляции 

0,9 и 0,2. 
3.6. Включить на модулирующий вход источ
ипа меандр и определить временную развертку и спектр АМ-сигнала 

при – m =
тветствовать частоте синусоидального источника. Выполнить 

анализ и определить временную развертку и спектр АМ-сигнала. 
Уменьшить ширину импульса в 10 раз и повторить анализ. 

3.7. Сравнить спектры игналов (ширина, орма, амплитуда) в пер-
вом и во втором случаях. 

3.8. Сформировать схемный проект модели детектора АМ
ючив в нее амперметр последовательно с диодом. Установить 

параметры выходного RC
3.9. Вывести на экран временные развертки выходного сигнала 

тока через диод. Выполнить спектральный анализ выходного сигнала 
и определить коэффициент нелинейных искажений по ф

2 2 2 2 2 2 2
2 3 4 1 2 3 4( ...) /( ...)гК V V V V V V V= + + + + + + + , 

где iV – гармоники амплитудного спектра выходного сигнала. 
3.10. Увеличить и уменьшить в 50 раз емкость или сопротивление 

выходного фильтра и определить временную развертку выходного 
возмож-

ные

 не-
лин

сигнала и коэффициент нелинейных искажений. Объяснить 
 причины изменения качества продетектированного сигнала. 
3.11. Путем многовариантного анализа определить наиболее оп-

тимальное значение параметров RC-цепи (менять R или C), при кото-
ром будет зафиксировано минимальное значение коэффициента

ейных искажений. Расчеты провести для шести точек изменения и 
фиксировать только значение Кг. 

3.12. Включить импульсный источник сигнала типа меандр с час-
тотой, соответствующей частоте синусоидального источника, и опре-

 
 



делить временную развертку сигнала на выходе детектора при индек-
се м

ю развертку напряжения на сопротивлении R = 
50 и в о

я исследований АМ-сигнала 
во временной области при гармоническом модулирующем сигнале 

На рис.13 приведена .  

В : 
MOD  

AM_ModTuned  находится в группе System – Mod/Demod. Парамет-
ры та 
несущего сигнала, Rout – выходное сопротивление. Ко входу RF in 

одуляции 0,5 и 1. 
3.13. Включить на выходе детектора последовательно-

параллельную RC-цепочку с параметрами С = 100 нФ, R = 50 кОм. 
Определить временну

кОм убедиться  отсутствии п стоянной составляющей. При 
необходимости для достижения установившегося режима увеличить 
интервал анализа в контроллере TRAN.  

4. Пример выполнения задания 

4.1. Формирование проекта для проведени

 схема проекта для проведения анализа

Рис. 13. Схемный проект для проведения исследований источ-
ника АМ-сигнала при гармоническом модулирующем сигнале 

 
состав проекта включены следующие основные компоненты

1  – модулятор, генерирующий АМ-сигнал. Компонента

компонента: ModIndex – индекс модуляции, Fnom – часто
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под

троллере Tran установить конечное время анализа (несколько 
пер

напряже-
ние ю зависимость выходного сигнала  
модулятора. На развертке установить маркеры в локальных максиму-
м

 

ключается гармонический источник несущего сигнала, ко входу 
MOD IN – источник модулирующего сигнала. Модулированный сиг-
нал генерируется на выходе RF out. В данном случае нагрузкой явля-
ется сопротивление 50 Ом, а для съема информации используется 
выходное напряжение с установленным именем Vout.  

SRC1 – источник синусоидального несущего сигнала. Компонента 
VtSine находится в группе Sources_Time_Domain. Параметры ком-
понента: Amplitude – амплитуда  сигнала (принять 1 В), Freq – частота 
сигнала.  

SRC2 – источник модулирующего синусоидального сигнала. Ус-
тановить для проведения исследований амплитуду 1 В. В данном 
примере установлено значение частоты модуляции 1 кГц.  

В кон
иодов модулирующего сигнала) и максимальный шаг, размер которого 

определить значением не более 1/20 периода несущего сигнала.  
Выполнить моделирование. 

 
4.2. Определение временных и спектральных характеристик АМ-сигнала 

Активизировать окно просмотра выходных результатов (
 Vout). Вывести временну

ах и минимумах огибающей, как показано на рис. 14. 
 

Рис. 14. Временная развертка АМ-сигнала 

 
 



С помощью к авнение для опре-
дел

омпонента Eqn сформировать ур
ен я глубины модуляции (рис. 15). После этого, используя таб-

личную форму визуализации данных (тип List), вывести рассчитанное 
значение, которое находится в блоке выходных данных (см. окно 
приложения List) Datasets and Equations>Equations>M . 

и

 
Рис. 15. Определение глубины модуляции 

 
Сформировать ализа с помощью 

раз
уравнение для спектрального ан

ложения выходного отклика в ряд Фурье с применением функции 
fs() (рис. 16). 

 
Рис. 16. Уравнение для спектрального 

анализа напряжения Vout 

В данном уравнении  вывода спектра 
уста

удный и фазовый спектры напряжения Vout (оп-
ции

 рекомендуется для более удобного
новить интервал Фурье-анализа (начальное и конечное время), соответст-

вующий периоду АМ-сигнала ( 1 и 2 мс соответственно) на последнем интер-
вале проведенного временного анализа, что позволит миновать возможные 
переходные процессы. Если переходных процессов не удается избежать, 
необходимо увеличить время анализа и повторить моделирование. Когда 
точное значение периода установить сложно, то нужно использовать функ-
цию fs() только с параметром Vout. Если заданное значение максимального 
шага анализа не соответствует временным изменениям сигнала, то программа  
выбирает его значение в автоматическом режиме. Выбранный шаг генериру-
ется в окне статуса после запуска проекта на моделирование и будет прини-
маться во внимание.  

Вывести амплит
 Magnitude и Phase), затем локализовать их в окрестности несу-

щей частоты и установить маркеры на реальных спектральных со-
ставляющих, как показано на рис. 17 – 18. 
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Рис.17. Амплитудный спектр АМ-сигнала 

Рис. 18. Фазовый спектр АМ-сигнала 
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4.3. Формирование проекта для проведения исследований АМ-сигнала 
во временной области при импульсном модулирующем сигнале 

 
Схема проекта приведена на рис. 19. 

Рис. 19. Схемный проект с импульсным модулирующим сигналом 
 
На рис. 20 приведены временная развертка сигнала, уравнение 

для Фурье-анализа и амплитудный спектр в децибеллах. Маркеры 
устанавливают приблизительно ширину спектра. В данном случае 
базовая (минимальная) частота в преобразовании Фурье определяет-
ся интервалом анализа, установленным в контроллере Tran по фор-
муле Fo = 1/(StopTime). Максимальная частота определяется интер-
валом анализа по формуле 

Fmax=1/(2MaxTimeStep). 

Если заданное значение максимального шага анализа не соот-
ветствует временным изменениям сигнала, то программа выбирает 
его значение в автоматическом режиме. Выбранный шаг генериру-
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приниматься во внимание при определении значения Fmax. 

После вывода спектра можно вать его в окрестности не-
сущ

ется в окне статуса после запуска проекта на моделирование и будет 

Рис. 20. Временная и спектральная характеристики 
АМ-сигнала при модуляции последовательностью 

 импульсов 

 локализо
ей частоты, как описано в п. 3.2. 

 
 



4.4. Формирование проекта для проведения исследований АМ-сигнала 
во временной области при  импульсном модулирующем сигнале. Оценка 

дена на рис. 21. 

 
В этом п ненты диода и 

его  (Diode и Diode_Model
Dev

 времени 

основных характеристик 

Схема проекта приве

 

Рис. 21. Схемный проект детектора АМ-сигналов 

роекте необходимо разместить компо
 модели   ), которые находятся в группе 
ices_Diodes, и амперметра I_Probe из группы Probe Components. 

 
Рис. 22. Временная зависимость тока через диод 
на всем анализируемом интервале
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На рис. 22 и тока через ди-
од в различных казана временная 
раз

 

– 23 приведены временные зависимост
масштабах времени. На рис. 24 по

вёртка напряжения на выходе детектора. 
 

 
Рис. 23. Временная зависимость тока через 

диод в узком интервале времени 

 
Рис. 24. Временная развертка напряжения 

на выходе детектора
 

 
 



Уравнение для провед а и амплитудный спектр 
приведены на рис. 25. Маркеры установлены на первых трех гармо-
ник

На ены уравнение и результаты расчета коэффициен-
та нелин 25). 

5.1. Цель работы, задани
5.2. Теоретическая ча ние основных харак-

теристик АМ-сигналов и остейшего детектора 
АМ

ти. 
ваний. 

ения Фурье-анализ

ах спектра. 
 

Рис. 25. Определение амплитудного спектра выходного напряжения 

рис. 26 привед
ейных искажений по установленным маркерам (см. рис. 

Рис. 26. Определение коэффициента  
нелинейных искажений 

 
5. Содержание отчета 

е. 
сть, включающая описа
 принципов работы пр

-сигналов. 
5.3. Схемные проекты для проведения исследований. 
5.4. Полученные в ходе моделирования и рассчитанные графиче-

ские зависимос
5.5. Выводы по каждому пункту проведенных исследо
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атематическое описание АМ-сигнала. Дайте опре-
дел  фак-
торы влияют на выбор 

от несущего и модули-
рую

тров. 
величение частоты мо-

дул
етектора присутствует постоянная состав-

ляю

Таблица 2 

Вариант несущей, 
МГц 

модуляции, 
кГц 

резистора, 
кОм 

емкости, нФ 

6. Контрольные вопросы 

1. Выполните м
ение индексу модуляции и способам его определения. Какие

несущей частоты?  
2. Определите спектр АМ-сигнала для произвольного сигнала.  
3. Определите спектр АМ-сигнала при однотональной модуляции. 
4. Каково должно быть соотношение част
щего сигналов? 
5. Принцип работы детектора АМ-сигнала. 
6. Объясните назначение RC-цепи на выходе детектора и принци-

пы выбора ее параме
7. К каким последствиям может привести у
яции или уменьшение несущей частоты? 
8. Почему на выходе д
щая напряжения  и как от нее избавиться? 

 
7. Варианты параметров сигналов и элементов схемы 

Частота Частота Значение Значение 

1 1 2 2 1 
2 2 10 1 1 
3 ,5 0,5 1 2 0
4 4 20 0,5 2 
5 1 10 4 1 
6 2 1 2 2 
7 0  ,5 1 2 4 
8 2 5 2 1 

 
 



Лабораторная работа № 3  
 

ИССЛЕДОВАНИЕ СИГНАЛОВ С ЧАСТОТНОЙ  
МОДУЛЯЦИЕЙ  

 
1. Цель работы 

 
Изучение и исследование временных и спектральных характери-

стик сигналов с частотной модуляцией (ЧМ); изучение принципов 
детектирования ЧМ-сигналов. 

 
2. Теоретическая часть 

 
Частотно модулированное колебание можно записать в следую-

щем виде: 

0 0
0

( ) cos ( )
t

a t A t dt
⎡ ⎤
⎢ ⎥= ω + θ
⎢ ⎥⎣ ⎦
∫ ,  ω(t) = ω0 + ks(t), 

 где A0 – амплитуда модулированного колебания, 
ω0 – несущая частота, 
s(t) – модулирующее колебание, 
k – коэффициент, 
θ0 – начальная фаза. 
Девиация частоты – максимальное отклонение частоты от час-

тоты несущего колебания, т.е. ωд = ωmax – ω0. Будем считать, что мо-
дулирующий сигнал является гармонической функцией тогда 

0 д( ) cos( )t tω = ω +ω Ω
, 

где Ω – частота модулирующего сигнала. 
В этом случае ЧМ-сигнал можно записать в следующем виде: 

 

0 0 0 0
0

д
0 0 0 0

( ) cos ( cos( )) cos(

sin( ) ) cos( sin( ) ),

t

дa t A t dt A t

t A t m t

⎡ ⎤
= ω + ω Ω + Θ = ω⎢ ⎥

⎣ ⎦
ω

+ Ω + Θ = ω + Ω + Θ
Ω

∫ 0 +
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где m = ωд/Ω – индекс модуляции. 
Таким образом, индекс модуляции ЧМ-сигнала представляет со-

бой максимальное отклонение фазы. 
Для неискаженной передачи сообщения необходимо, чтобы ши-

рина спектра сообщения была мала по сравнению с несущей ω0, а для 
это унк-
ции ω(t) было мало за один период  колебания T: 

 
Преобразуем косинус суммы

где

го нужно, чтобы относительное изменение модулирующей ф
  несущего

. 
Спектр ЧМ-сигнала 

 
Рассмотренный выше ЧМ-сигнал можно считать частным случаем 

сигнала с угловой модуляцией 

 

 0 0cos ( ), sin ( )A t A tθ  θ – м я амплитуды. 
Итак, ЧМ-сигнал можно  сумму двух амплитуд-

но-
спектра каждого из них достаточно сдвинуть на ω0 спектр огибающих 

 cosθ(t) и sinθ(t) являются нелинейными функциями 
ры этих функций могут существенно 

тличаться от спектра модулирующей функции S(t) и при одното-
нальной модуляции возможно возникновение кратных и комбиниро-

индексах модуляции (m << 1) 
мож t

едленно изменяющиес
 рассматривать как

модулированных колебаний (квадрупольных). Для определения 

своего аргумента θ(t), то спект
амплитуд, так как

о

ванных частот. Однако при малых 
но положить θ(t) = cosΩt, sin ( ) ( ) cost t mθ ≈ θ = Ω , тогда 

 
т.е. спектр, как и в случае с амплитудной модуляцией, состоит из 
несущей и двух боковых частей (но сдвинутых по фазе), а ширина 
спектра приближенно равна 2Ω. 

0 0 0( ) cos ( )cos sin ( )sin ,a t A t t A t t= θ ω − θ ω0

0 0 0 0 0 0cos cos sin cosA t A m t t A tω − Ω ω = ω −

0 0sin( ) sin( ) ,
2 2

m mA At t− ω +Ω − ω −Ω

( )a t =

( )d ( )t tω
dt T

ω

0 0( ) cos( ( )).a t A t t= ω +θ

<<

 
 



Но при больших индексах модуляции (m >> 1) за счет появле-
ния новых гармоник спектр расширяется и ширина спектра равна 
2mΩ = 2ωд (рис. 27). 
 

                   
 
 

ичных значениях индекса модуляции 

 
                          S(ω)                            S(ω)                             S(ω) 
                                           m << 1                         m = 1                          m >> 1                                              

 
                                              ω                                  ω                                  ω                                              

Рис. 27. Модуль спектральной плотности ЧМ-сигнала при 
разл

 

Частотное и фазовое детектирование 
 

Напряжение на выходе частотного детектора должно воспроизво-
дить закон изменения мгновенной астоты модулированного колеба-ч
ния, представив его в форме 

[ ]0 0( ) cos ( ) ,e t E t t= ω + θ

получим для идеаль  функцио-ного частотного детектора следующую
нальную связь: 

вы х ЧД ЧД( ) ( ) ,du t S S t
d t
θ

= = Δω

где SЧД = const — , выраженная в крутизна характеристики детектора
вольтах на единицу угловой частоты;  

( ) dt
dt
θ

Δω =  – мгновенное значение частотного отклонения входной 

ЭДС. Если пользоват  ься частотами / 2f =ω π , то в выражении

 

крутизна характеристики SЧД будет иметь единицу измерения вольт, 
делённое на герц

Предпо
и. Для ения из 

, спектр состоит 

вы х Ч Д( ) ( ) ,u t S f t= Δ

. 
лагается, что Δf(t), а следовательно, и uвых(t) являются 

«медленными» функциями времен выделения сообщ
частотно-модулированного колебания  которого 
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только из высокочастотных составляющих (несущая частота и боко-
-

ый детектор обязательно должен включать в себя 
нел

Д т  

има работы усилительного прибора, входящего в состав 
час

, представлена на рис. 28. В данной схеме 
тра

вые частоты модуляции), необходимо нелинейное устройство. Соот
ветствено частотн

инейный элемент. Однако в этом случае в отличие от амплитуд-
ного детектора для образования частот сообщения одного лишь 
нелинейного элемента недостаточно. ействи ельно, из вольт-
амперных характеристик нелинейных элементов видно, что при 
постоянстве амплитуды входного напряжения нелинейный элемент 
не реагирует на изменение частоты этого напряжения. Иными сло-
вами, нелинейность таких устройств, как диод проявляется лишь при 
изменении величины действующего на них напряжения, а не при 
изменении частоты или в общем случае скорости изменения сигнала. 
Поэтому обычный частотный детектор представляет собой сочетание 
двух основных частей: 1) избирательной линейной цепи, преобра-
зующей частотную модуляцию в амплитудную, и 2) амплитудного 
детектора.  

При правильном построении схемы частотного детектора изме-
нение амплитуды входного сигнала не должно влиять на величину 
выходного напряжения. Поэтому в схему частотного детектора 
обычно входит устройство для ограничения амплитуды входной 
ЭДС. Иногда ограничение осуществляется установлением специ-
ального реж

тотного детектора. 
В качестве линейной цепи можно использовать любую электри-

ческую цепь, обладающую неравномерной частотной характеристи-
кой: цепи RL, RC, фильтры, колебательные контуры и т. д. В высо-
кочастотной технике большое распространение получили колеба-
тельные цепи. Схема частотного детектора, содержащего простой 
колебательный контур

нзистор предотвращает шунтирование входным источником 
напряжения e(t) колебательного контура. В идеальном случае на 
модельных задачах можно использовать источник тока в качестве 
модулирующего воздействия, упрощая схему детектора. Если резо-
нансная частота контура ωр отличается от средней частоты модули-
рованного колебания ω0, то изменение амплитуды напряжения на 

 
 



контуре Uк повторяет в известных пределах изменение частоты 
входного напряжения, как показано на рис. 29. 

 
Рис. 28. Схема частотного детектора 

 

Изменение  на конту-
ре с  диода Д преобразуется в низкочастотное напряжение, 
которое выделяется на нагрузке R,C (рис. 29). Отметим попутно, что 
при точной настройке контура на частоту ωр = ω0 сигнал искажается; 
частота изменения о ше частоты полез-
ой модуляции. В исходном режиме, т. е. при отсутствии модуляции, 
раб

амплитуды Uк высокочастотного напряжения
помощью

гибающей получается вдвое вы
н

очая точка должна устанавливаться на скате резонансной кривой. 
Недостатком рассмотренной схемы является необходимость настройки 

контура на частоту, отличную от частоты немодулированного колебания. 
Кроме того, одиночный колебательный контур имеет весьма ограниченный 
линейный участок на скате резонансной кривой. Поэтому на практике, как 
правило, применяют более сложные схемы детектирования.  

 

Рис. 29. Принципы преобразования ЧМ-сигнала в АМ-сигнал 

 

34 



35

3. Задание 
3.1. Создать проект САПР ADS в рабочем каталоге. Установить 

аналоговый режим работы системы (команда главного меню 
Tools>ADS Setup>Analog RF only).  

3.2. Подготовить схемный проект для проведения анализа источника 
ЧМ-сигнала во временной области при синусоидальном модулирующем 
сигнале заданной частоты. Установить индекс модуляции m = 10. Вы-
полнить анализ на интервале 5 – 10 периодов модулирующего сигна-
ла. Вывести временную развертку ЧМ-сигнала на выходе модулятора 
и с помощью маркеров наблюдать изменение частоты (периода) сиг-
нала на некотором

3.4. Выполнить спектральный анализ выходного сигнала. Вывести 
амплитудный спектр ЧМ-сиг изованный в окрестности 
нес

переменного тока на входе де-
тек

овать в дальнейших исследованиях. 

уляции, равное 10. 
В

 интервале анализа. 

нала, локал
ущей частоты. С помощью маркеров определить ориентировочно 

полосу модулированного сигнала по максимальным значениям ам-
плитудного спектра.  

3.5. Повторить анализ п. 2.2, 2.4 для значений индекса модуляции, 
равных 20, 1, 0,1, 0,01. Наблюдать за изменением полосы сигнала и 
его мощности (лучше всего в децибеллах). 

3.6. Сформировать схемный проект модели детектора ЧМ-
сигналов для проведения частотного анализа. Установить параметры 
выходного RC-фильтра, исходные параметры колебательного конту-
ра, указанные в примере, и источник 

тора. С помощью многовариантного частотного анализа опреде-
лить такие параметры (L, C) колебательного контура, при которых 
частота несущего сигнала будет находиться приблизительно посере-
дине резонансной характеристики напряжения на контуре. Получен-
ные значения использ

3.7. Подготовить проект для анализа ЧМ-детектора в режиме про-
хождения модулированных сигналов методами анализа во временной 
области.  Установить значение индекса мод

3.8. ывести на экран временные развертки выходного сигнала. 
Выполнить спектральный анализ выходного сигнала и определить 
коэффициент нелинейных искажений по формуле  

 
 



где iV  – гармоники амплитудного спектра выходного сигнала. 
3.9. Повторить анализ п. 2.7, 2.8 при индексах модуляции, равных 20, 

1, 0,1, 0,01. Построить графики зависимости коэффициента нелинейных 
искажений и амплитуды выходного сигнала от индекса модул

НИ

2 2 2 2 2 2 2
2 3 4 1 2 3 4( ...) /( ...) ,к V V V V V V V= + + + + + + +

яции. 

и опре-
дел

я 

4.1. сигнала 
в гнале 

напряжения  при гармоническом  модулирующем сигнале 
 

В состав проекта включены следующие основные компоненты: 
VtSFFM – источник напряжения, генерирующий ЧМ-сигнал. Компо-
нент находится в группе Sources_Time_Domain. Параметры компо-
нента: ModIndex – индекс модуляции, CarrierFreq – частота несуще-

3.10. Повторить анализ п. 2.7, 2.8 при значениях частоты несущего 
сигнала, смещенной на 20 % выше и ниже заданного значения при m = 10. 

3.11. Меняя частоту модулирующего сигнала, от 1 до 20 кГц 
яя амплитуду первой гармоники выходного сигнала, рассчитать 

амплитудно-частотную характеристику ЧМ-детектора. Принять m = 10.  

4. Пример выполнения задани

Формирование проекта для проведения исследований ЧМ-
во ременной области при  гармоническом модулирующем си

 
На рис. 30 приведена схема проекта для проведения анализа.  

 
Рис. 30. Схема  проекта для проведения исследований источника ЧМ-
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го сигнала, Amplitude – амплитуда несущего сигнала, Signal_Freq – 
частота модулирующего сигнала. В данном случае нагрузкой является 
сопротивление 50 Ом, а для съема информации используется выход-
ное напряжение с установленным именем Vout.  

В контроллере Tran установить конечное время анализа (несколь-
ко периодов модулирующего сигнала) и максимальный шаг, размер 
которого определить значением не более 1/20 периода несущего 
сигнала.  

Выполнить моделирование. 
 

4.2. Определение временных и спектральных характеристик ЧМ-сигнала 

Активизировать окно просмотра выходных результатов (напряже-
ние 

Вывести временную зависимость выходного сигнала модулятора 
(рис. 31 мумах 
огибающей и

овать уравнение для спектрального анализа с помощью 
разложения выходного отклика в ряд Фурье с применением функции 

Vout).  

). На развертке установить маркеры в локальных макси
 оценить изменение частоты несущей.  

 
Рис. 31. Временная развертка ЧМ-сигнала 

Сформир

 
 



fs()

 
 

Рис. 32. Амплитудный спектр ЧМ-сигнала 
 

Если заданное значение максимального шага анализа не соответ-
ствует временным изменениям сигнала, то программа  выбирает его 
значение в автоматическом режиме. Выбранный шаг генерируется в 
окне статуса после запуска проекта на моделирование и принимается 
во внимание при расчете спектра.  

 
4.3. Формирование проекта для определения параметров колебательного 
контура ЧМ-детектора методами частотного анализа. Результаты расче-

та амплитудно-частотных характеристик напряжения на контуре 
 

Схема проекта приведена на рис. 33. В этом проекте необходимо 
разместить компоненты диода и его модели (Diode и Diode_Model), 
которые находятся в группе Devices_Diodes. Определить имя на-

 (рис. 32) и определить амплитудный спектр и полосу частот, 
занимаемую ЧМ-сигналом. 
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пря

 

Рис. 33.  

Результаты  (АЧХ) 
напряжения  рисун-
ке видно, что  наибо-

жения на контуре Vout_contur и напряжение на выходе детек-
тора Vout. 

лее соответствует частоте несущей 1,088 МГц. 
 

Схемный проект для определения резонансной характеристики
колебательного контура ЧМ-детектора 

 расчета амплитудно-частотной характеристики
на контуре Vout_contur приведены на рис. 34. На
 выделенный маркерами участок характеристики

 
Рис. 34. АЧХ напряжения на контуре  

 
 



4.4.

д-
ного сигнала приведена на рис. 36. С помощью маркеров можно убе-
диться в том, что период соответствует частоте модулирующего 
сигнала. 

 

 
Рис. 36. Временная развертка напряжения на выходе 

детектора 

 Формирование проекта и результаты оценки временных и спектральных 
характеристик выходного сигнала ЧМ-детектора  

 
Схема проекта приведена на рис. 35. Временная развертка выхо

Рис. 35. Схема проекта детектора ЧМ-сигналов 
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Уравнение для проведения Фурье-анализа, амплитудный спектр и 
результаты расчета коэффициента нелинейных искажений приведены 
на рис. 37. Маркеры установлены на первых трех гармониках спектра. 

 
Рис. 37. Определение амплитудного спектра выходного напряжения и 

 

 и 

графиче-
ские

 
опре-

факторы 

коэффициента нелинейных искажений 

5. Содержание отчета 

5.1. Цель работы, задание. 
5.2. Теоретическая часть, включающая описание ЧМ-сигналов

принципов работы простейшего детектора ЧМ-сигналов. 
5.3. Схемные проекты для проведения исследований. 
5.4. Полученные в ходе моделирования и рассчитанные 
 зависимости. 

5.5. Выводы по каждому пункту проведенных исследований. 

6. Контрольные вопросы 

1. Выполните математическое описание ЧМ-сигнала. Дайте 
деление индексу модуляции и частоте девиации. Какие 
влияют на выбор несущей частоты? 

 
 



2. Выполните математическое описание ФМ-сигнала. Дайте оп-
ределение инде яют на выбор 
несущей 

Приведите временные 
зависимости

3. Опред  мо-
дуляции 

4. Опред модуляции 
при малом

5. 
6. детекторе 

и принципы

7. Варианты параметров гналов и элементов схемы 

Таблица 3 

ксу модуляции. Какие факторы вли
частоты? 

 примеры сигналов АМ и ЧМ. Постройте их 
. 
елите спектр ЧМ-сигнала для случая однотональной

при большом значении индекса модуляции.  
елите спектр ЧМ-сигнала при однотональной 

 значении индекса модуляции. 
Принцип работы детектора ЧМ-сигнала. 
Объясните назначение колебательного контура в ЧМ-

 выбора его параметров. 

си

Вариант 
Частота 
несущей, 
МГц 

Частота 
модуляции, 
кГц 

Значение 
резистора, 
кОм 

Значение 
емкости, нФ 

1 1 2 2 5 
2 2 4 1 5 
3 2 0,5 1 10 
4 4 10 2 2 
5 1 1 4 1 
6 2 1 2 2 
7 0,5 0,5 2 4 
8 2 5 2 2 
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